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Login Process: 
(The Adminstrator password is admin)
The Login process is optional,
you can activate the login process
in the Preferences area. 
To start the Religious Suite application, just double-click on the Religious Suite application.

Once the application has been started, you will see a password dialog window (shown below).

Select user to login as, and then enter the password and press "OK".

As an administrator you can create and edit users. The default administration password is "admin".

Once you login, click on the Preferences icon on the palette. In the Preferences area you can add the owner’s information.
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If you have any questions, please contact support@mdansby.com
You can delete the sample information by pressing the delete button on the bottom of the screen. For an example, go to the Individuals area. Double-click on an Individual and at the bottom you will find the delete button. 

Getting Started with the Religious Suite 

Login as the Administrator / admin (The Login process is optional, you can activate the login process in the Preferences area) 
2. Place your account number in the Preference area and press the activate account button.
3. Enter your owner information in the preferences area.
4. Place your owner’s information in the Preferences area; name, address, and telephone.
5. Press Save to save the preference information
6. Go to the Individuals area, and setup your Members
7. You can delete sample Individuals by pressing the delete button at the bottom 
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Religious Suite Desktop:     

After your login, you will see the Religious Suite splash screen, palette and registration window.

If the application is registered, the registration window will not appear.

The Religious Suite application contains the following module Individuals, Forms, Address Book, Finance, Calendar, Schedule, Child Care, Messages, Invoices, Attendance, Library, Deceased and Preferences.
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These modules make up the Religious Suite application.

When you first start using the application, enter your Preferences and Individuals first, and then your Address Book.

Find the Individuals icon on the palette and double-click to open the Memberships module.
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New Record  

To create a new record, go to the area in which you want to create a new record.
Then press the new button, a new blank record will appear were you can insert your data. 

For an example, Go to the Individuals area, then press the "New Individual" or "New Member" button.
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Delete Record    

To delete a record, go to the record you wish to delete and double-click it.
Then press the "Delete" button, the delete button will delete the current record. 

For an example, Go to the Individuals area, Select the Record you wish to delete, and then press the "Delete" button.

You can only delete one record at a time.

Save Record   

To save a record, press the "Save" button and the record will be saved.

Close Windows   

To close any window, press the "Cancel" or "Done" button in the lower left hand corner of the window. 

You can also close a window by press the close box.              [image: image6.png]



Edit Drop Down Lists
To edit drop down lists, go to the Preferences area to the Drop Down List tab. 
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Once you select the list you wish to edit, you can add, modify, delete and sort elements in the list.

Always press "Save List", after you have made a list modification.

After you have upgraded the software, you can press the "Restore List" to restore your saved list.

Personalize Headers (Graphic & Text Banners)  

In the Preferences area, there is a button called "Show Banner on Reports".
If this button is checked the Graphic Banner will be displayed on reports.
If this button is not checked, then the regular company name or
organizational name will be displayed.
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You can create a banner in your paint program or Photoshop application.
The banner must be 600x100.

Show Print Preview - If checked, a print preview will always be displayed before Printing
Show Print Settings - If checked, the print setting option will be shown every time you print.  

Support (Support@Mdansby.com) - 24-7-365  

This quick overview help guide goes over the major points of the application.
If you are a registered user you can ask questions at any time, by emailing support@mdansby.com.

You can include your own forms, notices and agreements. In the Cases area,
click on the Forms tab. This is where you can include your own forms,
notices and agreements.

QuickTime player V6 is required for the Religious Suite application.
http://www.apple.com/quicktime/download/ 

<------------------------------------------------->
SEND SUPPORT SCREEN SHOTS
<------------------------------------------------->

Screen shots help explain your issue and makes it easier for us to help you. Please use the following steps to send us a screen shot.

1) Press the Print Screen button
2) Open your paint program.
3) Go to the Edit menu item, select paste
4) Go to the File menu item, select save image as (.bmp,.gif,.jpg)
5) Attach the image to your email, send it to support@mdansby.com

Send screen shots to support@mdansby.com via email or by fax to 001-646-219-2818.

<------------------------------------------------->
Importing & Exporting Data: 
<------------------------------------------------->

You can import contact information only.
Name, address, city, state, zip and telephone numbers.
Just select the option to import data under the file menu item.
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Click here for the 4D User Reference Manual
<------------------------------------------------->
Installing the Religious Suite Updates
<------------------------------------------------->
If you have made changes to the user and passwords,
You can save your list and reload it after your upgrade your software.

You should make regular backups of the Religious Suite once a month.
To make a backup, just copy the ReligiousSuite folder location in the Program Files Folder on your C drive.
Copy to another hard drive or burn it to a blank CD.

Images (Importing Multiple Image Types)  

The Religious Suite will be able to handle the following image types:
pic, pct, jpeg, gif, tiff, bit, png, bmp, psd, tga, pntg, tpic and bps.

Download the free QuickTime player, this plug-in will help process more types of images.
http://www.apple.com/quicktime/download/

If you are using a digital camera, just reduce the image size to reduce the image size. Images should not be larger than 100K.

Passwords (Edit Users & Passwords)   
In the login screen, only the following names should be displayed:
Administrator
Guest_BlankPassword

A) Login as the administrator (password is admin)
B) Click on the Preferences icon on the palette
C) Then, Click on the Edit Users button
D) Highlight the user named John Doe
E) Go to the password menu item and select Edit User
F) You should be able to change the users name and password here
G) Only change the name and password, nothing else

Do not rename the administrator user.


If you have created/saved your own Password/User List,
please use the following steps to save your User & Password Settings:

A) Go to the Preferences area and press the Edit Users button
B) Then, go to the Passwords menu item and select Save Groups.
C) Name and Save the file.
D) Install the upgrade
E) Then, go back to Preferences/Edit Users and load your user file.

You must assign users to groups.
Just drag and drop users on the groups you want the user to have access to
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Individual – Donations  

You can record individual donations on the Individuals donation tab, left side.     [image: image11.png]



Donations are actual money received.
All donations recorded are posted in the Finance area.

You can run income and expense reports against the data in the Finance area.

Individual - Pledges
You can record pledges on the Individuals donation tab, right side.

Pledges are not money received, but money promised.

All pledges recorded are stored in the Individuals area only.

You can transfer pledges to donations by clicking the transfer button.

You can run income and expense report on the data in the Finance area.
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Individuals: Forms Tab
Inside the Individuals area, under the Forms tab you can edit notices, forms
and agreements. You can create your own or import existing forms and
agreements.

On the left side, all your form, notices and agreement will appear. Just
double click on one to edit. On the right side, forms, notices and
agreements specifically for that Tenant will appear.

To insert the Individual name or Address,
Just click on the Insert menu item and select 4D Expression
Choose Individual and then Full_Name and and Address.

You can also right click in the word processing window to insert application fields.

You only have to create the form once, and you can use them with all of your Individuals. 

Click here for the 4D Write User Reference Manual
Individuals: Creating Labels & Barcode Labels
Click the label editor, its the button that says labels or the icon that
looks like an envelope. After the label editor is open you can drag the
item to build the label. The bar code field is called "BarCode_Image".

You can save your label template for use in the future. So, just save and
load later.

Backup Data (Manually)
Windows: 
Just save the contents of the Religious Suite folder in your Program
Files folder on the C Drive.

Macintosh: 
Just save the all the contents inside the Religious Suite folder.

You can copy this folder to another drive or burn the folder to a CD.

Your data is stored in the file named ReligiousSuite.data.
You can rename the data file if you wish (YourName.data).

We recommend that you backup the Religious Suite to a CD blank once a month.

Just drag and drop the Religious Suite folder on to your CD-RW drive and create a backup.

Backup Data (Automatic - Local)
Select Backup – Local under the File menu item.

Press the Preferences button, when the backup process window opens.

Go to Backup, select schedule, select one week or month.
Go to backup and select the destination of the backup.
Go to Restore and make sure all three check boxes are checked

DO NOT BACKUP MORE THAN ONCE A WEEK.
WE RECOMMEND ONCE A MONTH.
Backup Data (Automatic - Online)
If you order the online backup or offsite backup (backup module),
go to the Preferences area and select the day of backup.

Go to the Preferences area and select the day of the week, the application will upload
your data to the Backup Server once a week.

If you need to recover your data just send an email to support@mdansby.com,
Support will reply with a link to download the most recent
backup copy of your data file.
Moving To a New Computer
Windows: Please use the following steps to move your Religious Suite data to a new computer:
1. Go to the C drive / Program Files / ReligiousSuite folder / Database folder
2. Copy / Burn to a CD the file named "ReligiousSuite.4DD"
3. On the new computer, download the Religious Suite trial from our website.
4. Install the Religious Suite Trial version
5. After installation, copy the file on your CD to the Religious Suite folder.
6. Your data is now in place. You can start the Religious Suite on the new computer.


Macintosh: Please use the following steps to move your Religious Suite data to a new computer:
1. Go to the C drive / Program Files / Religious Suite folder
2. Copy / Burn to a CD the file named "ReligiousSuite.data"
3. On the new computer, download the Religious Suite trial from our website.
4. Install the Religious Suite Trial version
5. After installation, copy the file on your CD to the Religious Suite folder.
6. Your data is now in place. You can start the Religious Suite on the new computer.

Printing Reports
Most of the Reports are located in two places.
1) Under the Reports - menu item at the top of the screen.
2) Inside each module - at the bottom of the screen
Sample: Individuals, print Individuals statements and print Individuals invoices.

Printing Checks (Finance Icon / Area)
You can use magnetic ink to print 100% legal checks on totally blank check stock.
Simply insert the blank check stock into your printer tray, and print your checks.

Press the design check button to design your checks. Press the print check button to print your checks.
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Preferences Icon / Area
In the Preferences area, there is a button called "Show Banner on Reports".
If this button is checked the Graphic Banner will be displayed on reports.
If this button is not checked, then the regular company name or
organizational name will be displayed.
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You can create a banner in your paint program or Photoshop application.
The banner must be 600x100.

Show Print Preview - If checked, a print preview will always be displayed before
printing.
Show Print Settings - If checked, the print setting option will be shown every time you print. 

Schedule Icon / Area
Creating Events/Objects

To create an Event record, the user can position the mouse pointer within
the Schedule area
and then point, click and drag a rectangle within the date (or resource) and
time area desired.
If you wish to create an event record/object (physically) on top of an
existing Event/object, you
must depress and hold the option key down and then perform the point-click &
drag operation.

Deleting Events/Objects

To delete an Event record, the user can select an event object within the
Schedule area, then
press Control-Delete (Windows) or Command-Delete (Macintosh).

Moving Events/Objects
To move an Event record, the user can point, select and drag an object to
another cell within the
Schedule
area. Dragging between non-timed Banner events and regular events and vice
versa
is not permitted.

Resizing Events/Objects

To resize an Event record, the user must position the mouse pointer at the
bottom of the Event
object. Once the cursor changes to the cross-heir status, the use can click
on the bottom of the
object and drag it downward to establish a new end time. Whether creating or
moving and object,
it is only possible to create an end-time which corresponds to the currently
shown interval. As a
developer, either provide an interval tool which allows end-user to alter
the time intervals shown or
provide direct access to an input dialog or form for editing.

Coloring Events/Objects
To change the color of an Event/object, the user can control-click on an
event/object which then
automatically displays the Color palette pop-up. The User can then drag the
mouse pointer to the
desired color cell and release the mouse to select that color. To cancel the
color pop-up, the User
can simply drag off of the palette.

Tabbing
Schedule manages and maintains a list of selected cells throughout an
application session. By
depressing the Tab key the User can Tab between the events most recently
edited. Alternatively, by
depressing the Shift and Tab keys concurrently, the User can tab among these
events in reverse
order.

Calendar Navigation
When the area is displayed to the user, they may select any date in the
currently displayed month
simply by clicking on it. The calendar will always have exactly one date
selected. The user may
scroll to the next or previous month by clicking on the arrow buttons in the
upper-right or upper left
corner of the area. If the user holds down the Command key when clicking on
these buttons,
the calendar will scroll to the next or previous year.

Scrolling the calendar does not change the selected date - the user must
click on a date cell in order
to do so. If the currently selected date is in a month other than the one
currently displayed in the
area, the user may "jump" to the month of the currently selected date by
clicking on the title-bar 
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Error Messages 

--------------------------------------->
ERROR MESSAGE #9939
--------------------------------------->

Please use the following steps to correct an Error Message #9939:

A) Go to the Religious Suite Folder in your C drive / Program Files
folder. View window by Details and sort by Type.

B) Copy the file named "ReligiousSuite" with the file type "4D Data File"
to you desktop.

C) Go to your control panels and uninstall the Religious Suite application.

D) Download the Religious Suite - Trial Version and save to your desktop
Windows Version
<http://mdansby.com/downloads/RSW2003.exe>
http://mdansby.com/downloads/RSW2003.exe
Macintosh Version
<http://mdansby.com/downloads/RSM2003.sit>
http://mdansby.com/downloads/RSM2003.sit

E) Install the Religious Suite and hit cancel a the password dialog window.

F) Place the "ReligiousSuite" with the file type "4D Data File" on your
desktop to the ReligiousSuite folder. This folder is on your C drive in
the Program Files folder. It will ask to replace the file, select yes.
Start the Religious Suite now.
PocketPC Module
Please use the following steps to setup the Religious Suite / PocketPC .

1. Go to the Preference area and set the PocketPC Backup path.
2. Also set the Desktop or PocketPC Install or PocketPC add-on path.
3. Under the Palm/PocketPC menu item and select synchronize all.
4. Go to the path set in your preferences for Desktop path.
5. Move the file to your PocketPC device.

The Religious Suite places the data in a format that you can read and write on you PocketPC device.
(Excel File Format)

If you have any questions, please don't hesitate to ask.

PalmOS Module
To sync with Microsoft Outlook and iCal, go to the Mobile menu item and select sync with Outlook and iCal.

Preferences Icon / Area
In the Preferences area, there is a button called "Show Banner on Reports".
If this button is checked the Graphic Banner will be displayed on reports.
If this button is not checked then the regular company name or
organizational name will be displayed.

You can create a banner in your paint program or Photoshop application.
The banner must be 600x100.

Show Print Preview - If checked, a print preview will always be displayed before
printing.
Show Print Settings - If checked, the print setting option will be shown every time you print.

<------------------------------------------------->
Fonts: 
<------------------------------------------------->

The font can not be changed on the Statement and Invoices.
But, you can change the fonts for the notices, agreement and letters.
Just go to the Tenants, notices tab. You can create, edit all the forms there.

Religious Suite Desktop: Families Module (List Screen) 

After you double-clicked on the Families icon, a list of families is shown.

Below in the screen shot there are two Families in the list.

To see the detailed Families information, just double-click on the court (Double-click selection to open) and the detail screen will appear.

Cancel - closes the window.

All Records - displays all records.

New Family - creates a new member to track.

Search - allows you to query information in the court area.

Sort - allows you to sort information, based on the criteria you set.

Labels - allows you to create mailing labels.

Quick Report - allows you to generate reports, based on the information saved in this module.

ABC's Letters - allows you to quickly search by the first character in the last name.

Religious Suite Desktop: Families Module (Detail Screen)
The detail screen displays the Families detailed information.

The Families information allows you to track the families’ members.

Cancel - closed the detail window and reverts back to the List screen.

Save - saves the information.

Delete - delete the information.

"<" - previous record

">" - next record
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Religious Suite Desktop: Individuals Module (Detail Screen)
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The detail screen displays the Individuals detailed information.

The Individuals information allows you to track the following type and address.

Cancel - closed the detail window and reverts back to the List screen.

Save - saves the information.

Delete - delete the information.

"<" - previous record

">" - next record

The following screen shot shows the Membership type in the General tab.
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The screen is the General tab; on the General tab you can insert important information about the individual. 

The following screen shot shows the Custom Field tab.
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On the Custom Field area, you can enter anything you wish to keep track up.

You can name the Custom Fields in the Preferences area.

The following screen is the Photos tab.
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On the Photos tab you can import your photos or pictures in the Individuals file.

The Religious Suite will be able to handle the following image types:
pic, pct, jpeg, gif, tiff, bit, png, bmp, psd, tga, pntg, tpic and bps.

Download the free QuickTime player, this plug-in will help process more types of images.
http://www.apple.com/quicktime/download/

If you are using a digital camera, just reduce the image size to reduce the image size. Images should not be larger than 100K.

The screen is the General tab; on the General tab you can insert important information about the individual.
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The Religious Suite will be able to handle the following image types:
pic, pct, jpeg, gif, tiff, bit, png, bmp, psd, tga, pntg, tpic and bps.

Download the free QuickTime player, this plug-in will help process more types of images.
http://www.apple.com/quicktime/download/

If you are using a digital camera, just reduce the image size to reduce the image size. Images should not be larger than 100K.

The following screen is the Dates tab. 
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The following screen is the Forms tab.
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Inside the Individuals area, under the Forms tab you can edit notices, forms
and agreements. You can create your own or import existing forms and
agreements.

On the left side, all your form, notices and agreement will appear. Just
double click on one to edit. On the right side, forms, notices and
agreements specifically for that Tenant will appear.

To insert the Individual name or Address,
Just click on the Insert menu item and select 4D Expression
Choose Individual and then Full_Name and Address.

You can also right click in the word processing window to insert application fields.

You only have to create the form once, and you can use them with all of the Individuals. 

Click here for the 4D Write User Reference Manual
Religious Suite Desktop: Messages Module (List Screen) 

After you double-clicked on the Messages icon, a list of messages is shown.
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In the screen shot there is one message in the list.

To see the detailed message information, just double-click on the message (Double-click selection to open) and the detail screen will appear.

Done - closes the window.

All Records - displays all records.

New Individual - creates a new message to track.

Search - allows you to query information in the message area.

Sort - allows you to sort information, based on the criteria you set.

Labels - allows you to create mailing labels.

Quick Report - allows you to generate reports, based on the information saved in this module

Religious Suite Desktop: Message Module (Detail Screen) 

Religious Suite Desktop: Message Module (Detail Screen)
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The detail screen displays the Message information for our operation.

The Message information allows you to track the following messages, Telephone, Date, Time, Taken By, and Status,

Cancel - closed the detail window and reverts back to the List screen.

Save - saves the information.

"<" - previous record

">" - next record

Delete - delete record

Religious Suite Desktop: Preferences Module (Detail Screen)
Save your company or organization information and setting in the preferences

Palette on the Right - allow you automatic set the palette to appear on the right.

Currency - Set the currency standard

Logo - allows you to save your logo for it can appear on printed reports.

Edit Users - allows you to add and edit users to the application.

Popup List - allows you to maintain a list of items that will appear in popup list in the application.

Registration - allows you to register the application.

Creating a QuickReport
To build the report: 
1 Double-click the field Cases_Full_Name in the Select the fields area.
2 While the column is still highlighted, click the Sorted check box.
3 Double-click the following fields to add them to your report: 
Address, City, StateProvince, ZipCodePostalCode, Current_Balance_Due
As you double-click each column, it is added to your report. Your
report now looks like this: 
4 Click the Scroll Bar right arrow or expand the window so you can see
the column Current_Balance_Due.
The Current_Balance_Due column should already be highlighted. If it is not, 
click at the top of the column to highlight it.
5 Click the Sum button in the Cell Summary area.

Creating Labels
To design the labels: 
1 Click the Label tab to go back to the Label design page.
2 Drag the field Cases_Full_Name so that it is positioned near the top of the
label in the label design area.
3 Drag the field Address to the label.
4 Drag the field City, StateProvince and ZipCode_PostalCode to the label.
5 Choose Select all in the Edit menu.
6 Click the Align Left icon.
7 Choose Times in the Font pop up menu.
8 Click Left in the Justification pop-up menu.

Importing Data into the Religious Suite
To import the text file into the Religious Suite:
1 Choose Import Data… in the File menu.
The operating system’s standard Open File dialog appears.
If you are not already in the directory, locate your file, the file must be text file (.txt)

Note: These dialog boxes
may vary depending on the
version of your Operating
System
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Importing Records into the Individuals or Address Book areas
2 Double-click the file to open it.
The 4D Import Wizard appears, showing you the contents of the
import file. If necessary, you can align the columns with the file
import file with the fields in your database.
The Import Wizard assumes that the data in your import file is in the
same order as the fields in your database. However, if some of the field
choices are not correct, you can select a different field to import a
column into by choosing a field from the pop-up menu at the top of
that column.
For additional information, and for help with specific importing
challenges, see the 4th Dimension User Reference Manual.
3 Click the Import button.
4D returns to the [AddressBook] Output form, which displays the
20 records that you just imported. Note that the top of the window
now says “AddressBook: 20 of 21,” which means that you now have a
total of 21 records in your database.
Selected table
Field associated
to each column
Contents of the
import file

Click here for the 4D User Reference Manual
Click here for the 4D Write User Reference Manual
The following screen is the Finance screen.
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On the Finance area you can switch between account and generate reports on income and expenses.

The following screen is the Education / Groups listing screen.
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On the Education / Groups area, you can create groups of people for classes, gatherings and study sessions.

The following screen is the Education / Groups input screen.

You can add Individuals to the group here, shown below.

Press Add Student to Class, and select the Student by choosing the students name in the list.

The following screen is the Attendance Listing screen.

[image: image29.png]Your Religious O

Date
091072008
0812372008
0812372008
0812372008
0812372008
082112008
0410612008

Attendance:

Worship / Education / Groups

Your Religious Diganization Name Goes Here

ganization Name Goey Here # Attendance: 7 of 7

Crrae ]

Education  Group | Age Group | Present/Late | T

BIBLE STUDY.
BIBLE STUDY.
General
BIBLE STUDY.
BIBLE STUDY.
BIBLE STUDY.
Warship

Dokle ik seectin o open

100%

100%

Instructar / Teacher

John Dae
John Doe

John Doe
John Doe
John Doe
John Doe

S Subeat

Subject/ Description

Adult Sunday School
Adult Sunday School

Adult Sunday School
Adult Sunday School
Adult Sunday School

Gl o the soumm e 1 sor (Fress ShF ey 1o reverse 5o

([oone | Apecorts ][ few sendnoe

=]

Gk seah | me seah

|t

 Z00ansTE





Here you track attendance by date; you can create a new attendance record by clicking the New Attendance button.

The following screen is the Attendance Input screen.
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On this screen you enter the date, select group and mark students present, late or excused.

Students are present by default.
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